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1 Introduction 
 
MAGIQ is the new guider system at the Keck Observatory.  It consists of new guider cameras 
for each instrument, and new software packages to control the camera and display and 
manipulate the guider images.  The new cameras are much more sensitive than the original Keck 
guider cameras, which are no longer manufactured.  The new software, and especially the new 
user and OA interfaces, are much more powerful than the old ones.  They incorporate many new 
features summarized below. 
 

• The new MAGIQ software allows the user to share a target list with the OA, and to 
highlight choices on it.  This makes indicating the next object very straightforward, 
avoiding repeating long strings of numbers verbally.   

• Overlays of the fields of objects in the target list with the DSS are now possible.    
•  The observer’s GUI (graphical user interface) now has controls for image brightness, 

contrast, etc which are independent of those used by the OA.   
• Image has an overlay of compass rose and scale ruler. 
• Previews of objects (when they can be observed given the elevation and azimuth limits of 

each Keck telescope), and airmass as a function of sidereal time can be displayed. 
• There are plots of seeing, guide star brightness, and sky brightness and SNR as a function 

of time as well.   
• Eventually MAGIQ will permit continuous focus, but that is not yet implemented.   
• Most areas on the UI have tooltips that will display if the mouse is left hovernig on an 

area. These provide some description of what the button or field is for. 
 
Details of how to use each of the new features are given below.  Sections marked “Advanced” 
can be ignored until you are more familiar with MAGIQ and its capabilities. 
 
The observer’s GUI is now much more powerful than before, with these and many other new 
features.   You are encouraged to read the details below of how to use each of them, and try 
things for yourself.  The observer’s GUI (unlike the OA’s GUI) has no  way to send commands 
to the telescope or the guider camera, so nothing you can do while trying things out can affect 
guiding, nor mess up the guider camera or the GUI.  If the GUI appears to hang up, just stop the 
MAGIQ observer UI and then restart it. 
 
If, however, you are a newcomer to Keck, you might feel more comfortable not taking advantage 
of any of these features until you are more experienced.  In that case, you can just treat the 
observer’s GUI as a display for the guider image, and just look at it; this is a completely 
acceptable way of observing as well.  
 

1.1 How to start and stop MAGIQ 
The observer’s GUI is brought up from the guider eavesdrop pull down menu on any of the Keck 
instrument control computers.  The GUI comes up initialized for the instrument currently 
installed.  This pull down menu should also be used to stop the GUI at the end of the night. 
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2 MAGIQ Menus 
The menus are listed at the top of the MAGIQ observer’s GUI. 
 

 
• File – lets you load and append to starlists  
• Catalogs – lets you choose which catalog to use for overlay queries 
• Image Archives  - lets you choose which image archive to use for DSS image retrieval 
• Preferences – lets you set global preferences 
• DSS– lets you manipulate or view attributes about the DSS image 
• Camera - lets you manipulate or view attributes about the camera image 
• UserImage – lets you manipulate or view attributes about a user loaded image 
• Themes – lets you choose different look and feels 
• Layout Manager – lets you control the layout of the UI 
• Show View – lets you make any panel visible and to the front 

3 The UI in general 

3.1 Tooltips 
Most areas on the UI have tooltips that will display if the mouse is left hovering on an area. 
These provide some description of what the button or field is for. 

3.2 Am I connected ? 
The MAGIQ title bar shows the current connection status. It shows which instrument and 
telescope MAGIQ is connected to. If there is a problem with the communication between the UI 
and the MAGIQ server it will show here (in addition to the log file), saying “trying to connect”, 
“disconnected” or the instrument and telescope name when properly connected. 
 

 
Figure 1 UI Title bar 

Another quick sanity check is to examine the telemetry and guider panels. If these values are not 
updating then something is probably wrong.  
 

3.3 Right mouse clicks (popup menus) 
Most MAGIQ functions are done directly from the various panels. Tables, graphs and image 
displays all have right mouse click enabled popup menus.  
 
See the MAGIQ primer (the feature summary given as Appendix A of this document) for a brief 
overview and list of  the available commands and features with very short explanations for each. 
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4 Acquisition and Guider Images 
Camera images come in two forms: 

• Full frames  
o Use for acquisition, can be binned as needed. Updates periodically while guiding. 

• Guider sub frames 
o Used for guiding. Sub images are not binned.  
 

Camera images update automatically once the OA starts the MAGIQ hardware. The current 
camera name is displayed on the title line at the top of the image display. 
 
The guide star itself appears in a small box (region of interest) within the full guider image. This 
small region of interest updates more frequently than does the entire guider image. So if the 
target object looks as though it may have drifted slightly off the desired position,  wait until the 
next full image update before asking the OA to tune up the guide star position. 
 
The guide box is surrounded by a box. Typically this box is blue when guiding on an object.  If 
the OA is performing centroiding only and not actively guiding then  this box will be red. The 
FWHM and centroid location within the guide box is displayed by a circle that is drawn over the 
image. If there is problem determining the centroid of the guide star,  this circle will turn red. 
 
Note: When first turned on, the UI must receive a full frame image before guider images display 
begins.  
 
What gets displayed on an image display? 

• Camera Image (including sub-images), User or DSS image 
• Guider compass rose for RA, Dec and az,el 
• Scale ruler 
• Optional guider Pointing Origins and FOV (FOV only for DSS) 
• Optional overlay of catalog entries (item names may be shown or hidden) 
• Optional grid showing RA and Dec at intersections 
• Fiducial points on camera image 
• Marker to indicate observer specified location on camera image 
• Status information 

 
The MAGIQ Image Display control is a composite of controls. It includes: 

• A control toolbar 
• An image display area 
• A pan and zoom overlay 
• A cut level and color bar control  
• An image status area.  

 



MAGIQ Software Team     Page 9 of 38 
Observers User Interface Guide for MAGIQ     Revision: 0.03 10/6/2008 
 

 
Figure 2 Camera image display 

4.1 Adjusting Images 
Images can be adjusted in the following way: 

• Color 
• Scale 
• Zoom 
• Intensity 
• Cut Levels (black and white) 
• Contrast and Bias 

 
There are two control bars, one above and one below the image that allow these items to be 
changed. 

 
 

 
Figure 3 Image control bars 
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Along the top is the control bar which allows manipulation of the current display. In order from 
Left to Right the control bar has the following widgets: 

• Color selection 
• Image Scale Algorithm selection 
• Advanced cut level dialog – including image histogram 
• Zoom in 
• Zoom out 
• Zoom to fit (i.e. fit to current window size) 
• No Zoom – image displays at normal size 
• Current zoom and binning (zoom is identified as nx and binning as nb) 
• Toggle Pointing origins overlay on/off 
• Print current image 

 
Along the bottom is the control bar which allows further manipulation of the current display. In 
order from Left to Right this control bar has the following widgets: 

• Contrast and bias slider 
o The left hand side has the contrast and bias levels controls. The image allows DS9 

style contrast and bias controls by holding down and dragging the right mouse 
button within the image display window and the sliders can be used in 
combination or as an alternative to this. 

• Cut level algorithm 
• Image Intensity selection 
• Default button – restore all default options 

 

4.1.1 Color 
Sets the colormap for the image. The default is a greyscale from black to white, but false colors 
can be applied. Changes are applied as soon as a color is selected from the drop on the control 
bar.  

4.1.2 Scale 
Scale is used to set the distribution of colors based on pixel values. Changes are applied as soon 
as a scale algorithm is selected from the drop on the control bar. Using the drop down the color 
distribution can be changed to linear, log, squared, square root, and histogram or amplify small. 

4.1.3 Zoom 
By default an image is auto sized so that is fits into the current window size. This can be changed 
by using the zoom capability.  There are two ways to zoom an image: 

• Using the mouse 
• Using the zoom buttons on the control bar 
 

Note: the current zoom factor and binning are displayed on the top control bar. 
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4.1.3.1 Zooming using the mouse 
If a mouse wheel is present it can be used to cause the image to zoom in and out once the cursor 
has been positioned in the display window. 
 
If no wheel is present the middle mouse button can be used by holding the button down and 
dragging the mouse in the vertical direction. Moving up will zoom in, down will zoom out. 
 

4.1.3.2 Zooming using the control bar 
There are 4 buttons 

• Zoom in 
• Zoom out 
• Zoom to fit (i.e. fit to current window size) 
• No Zoom – image displays at normal size 

4.1.4 Contrast and Bias 
Contrast and Bias can be changed by using right mouse button and drag or by using sliders. The 
left hand side of the bottom control bar has the contrast and bias levels controls. The image 
allows DS9 style contrast and bias controls by holding down and dragging the right mouse 
button within the image display window.  The sliders can be used in combination or as an 
alternative to this. 

4.1.4.1 Using the mouse 
The contrast and bias of the current colormap can be changed by holding down the shift button 
while clicking and dragging the right mouse button. Contrast is changed by moving the mouse in 
the vertical direction and bias is changed by moving the mouse in the horizontal direction. 

4.1.4.2 Using the sliders 
The sliders can be used instead of the mouse. The sliders do not give the same extreme range that 
the mouse button provides. There is a separate slider for contrast and for bias.  Moving the slider 
in one direction will increase contrast or bias and moving in the opposite direction will decrease 
it. 

4.1.5 Intensity 
Rearranges the order of the colors in the colormap. Ramp is the default. Changes are applied as 
soon as a intensity type is selected from the drop on the control bar. Using the drop down the 
intensity distribution can be changed to equal, exponential, gamma, log, negative, negative log or 
ramp. 

4.1.6 Cut Levels 
Cut levels are used to set the upper and lower limits based on pixel values. There are four 
choices for the automatic application of cut levels: 

• MinMax, % 
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o Set the upper and lower limits to based on the specified percentage. A histogram 
of the data is created and the limits are set to display the percentage, about the 
mean value. For minmax the percent is set to 100%.    

• ZScale 
o Set the upper and lower limits base on the IRAF ZScale algorithm. ZScale 

parameters may be configured via the detailed cut level dialog.   
• JSky 

o Set the upper and lower limits base on the JSky algorithm.  This choice is 
particularly useful when the sky is very bright or rapidly varying (e.g. at twilight). 
JSky may be configured via the detailed cut level dialog.   

• Mean 
o Set the upper and lower limits base on a standard deviation about the mean. Mean 

parameters may be configured via the detailed cut level dialog.   
 
The automatic settings can be changed to manual and in this case the cut levels are determined 
by the user. 
 

4.2 Marking images 

4.2.1 Fiducial Marks 
 Fiducial marks can be placed on the image by right clicking on the image and choosing “Mark 
Fiducial Point”. Use “Clear Fiducial Points” to remove marks. Choosing this menu item will 
create a numbered circle around the current mouse position on the display. Any number of 
fiducial points can be marked. 

4.2.2 Marking a location on the OA screen 
A location on the OA’s UI can be highlighted by right clicking on the image on the observer’s 
GUI and choosing “Set Marker”. This will cause a mark point to appear in the same location on 
the camera image displayed on the OA’s screen. This provides an easy way to identify a point on 
the camera image to the OA without having to read out X,Y positions. Subsequent calls to Set 
Marker will remove the previous marker from the OA’s GUI and mark the new location.   Use 
“Clear Marker” to remove a mark. 
 
Any number of fiducial points can be set locally on the observer’s GUI, but only one location 
(the latest one marked) can be highlighted on the OA UI. 

4.3 Saving Images 
The current full frame image can be saved as a bitmap, jpeg or in FITS format. To save an image 
right click and select “Save as …”.  The resulting file appears in the nightly directory. 

4.4 Printing Images 
The current image can be printed by pressing the “Print” button on the top control bar. This is the 
last button on the bar. The image is printed as it appears on the screen with the compass rose 
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overlays, any fiducial points etc. In addition current telemetry information is also included as a 
footer. 
 

4.5 Image Information 
At the bottom of the image display is an image status bar. 

 
Figure 4 Image status area 

 
All regions on this control have tooltips. The data displayed in each subpanel is as follows, in 
Left to Right order: 

• Cursor position of the mouse 
• Pixel value at the mouse position 
• RA, Dec at the mouse position 
• Az, El at the mouse position (only valid for guider camera image) 
• RA, Dec offset in arcsec between the current mouse position and current Pointing Origin 
• Guider image X,Y coordinates in mm  from current PO to mouse position 

 

4.6 Pan and Magnify 
There is a small drop down on the top right hand side of each display image. This can be used to 
toggle the appearance of the pan and magnify window.  

4.6.1 Magnification 
Magnification is automatic. As the mouse is moved around the main image the magnify window 
updates with a scaled image for that region around the mouse. 

4.6.2 Panning 
Panning is only valid if the image has been scaled such that its size is larger than the available 
screen real estate. The panning window will show what portions of the image are currently 
displayed in the display area by drawing a yellow box around that area. The image can be panned 
by selecting an area in the panner window with the left mouse and dragging the mouse in the 
direction of choice. 
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Figure 5 Pan and Magnify 

4.7 Image Analysis 
This is only applicable for camera images. It will not work for DSS or other externally generated 
images that you may have loaded into the MAGIQ display.  Select Camera->Examine Objects 
from the top menu to bring up the “examine objects” window. 

 

By selecting on an object in the image display the examine 
object window will update to display the following 
information: 

• X,,Y position 
• RA, Dec for that location 
• Mean background for the region around the mouse 
• Peak value above background 
• FWHM 
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5 DSS Images 
DSS images are automatically retrieved any time a target is selected from the starlist. Once a 
DSS image is retrieved it is cached locally. DSS images for the entire starlist can be pre-cached 
at the start of the evening by right clicking on the starlist and selecting “Fetch DSS and catalogs 
for starlist”.  The default is DSS2R images. 
 
The DSS images retrieved for use with MAGIQ have a FOV of 0.1 degrees.  In addition to the 
standard image manipulation functions the following functions are available for DSS images. 
 

• Overlay the guider FOV and pointing origins 
• Overlay catalog information onto the DSS. 
• Rotate the DSS image to a given angle 
• Auto rotate the DSS image to track the guider angle 

 
The same image display component used for camera images is used for the DSS. For details on 
how to adjust images see 4.1 

5.1 Overlay the guider FOV and pointing origins 
The last button on the top control bar of the DSS image is titled FOV and can be used to toggle 
the guider FOV and pointing origin overlay. The FOV box and pointing origins will track the 
currently selected PO.  

5.2 Overlay catalog information onto the DSS. 
The second last button on the top control bar of the DSS image is an icon showing a tabular list 
in magenta and can be used to toggle an overlay of catalog information on the DSS. The catalog 
information is retrieved any time a target is selected in the starlist. Catalog information is cached.  
 
If the catalog overlay is visible it is possible to interact between the overlay on the DSS image 
and the catalog table. Clicking on an overlay item in the DSS will highlight that item in the 
catalog table. Likewise clicking on an item in the catalog table will highlight that item on the 
overlay by setting it yellow. 
 
Items from the catalog are overlaid as oval shapes on the display. The radii of the ovals are 
scaled to the magnitude of the catalog item. 

5.2.1 Displaying catalog item names 
From the top level menu choose Preferences->Show GSC Names to have the name of each 
catalog item shown next to the item on the overlay. This is only useful for fields that are not very 
crowded. 

5.2.2 Display a grid 
From the top level menu choose Preferences->Show GSC Grid to superpose a  grid  as part of the 
overlay. This grid is presented as a 4 * 4 grid with the RA, Dec coordinates displayed at each 
vertex. 
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5.3 Rotate the DSS image to a given angle 
To rotate the DSS to a given angle, enter the angle in degrees into the text box adjacent to the 
rotate button on the top control box.  The rotate button is represented as a curving arrow. Click 
the button to rotate the DSS. To remove the rotation, enter 0 into the box and press rotate. 

5.4 Auto rotate the DSS image to track the guider angle 
To have the DSS automatically track the guider angle, click the synch button on the top control 
bar. This button is represented by two curving arrows that point towards each other. This is a 
toggle button. The same button is used to turn on and off this tracking capability. 
 

6 User Images 
All the above features applicable to DSS images can also be applied to user-supplied images.. 
User images are not loaded automatically but can be loaded on demand by a user through the 
File menu. Select File-> Load Image to bring up the file selection dialog. Choose a file and then 
press “Select image to load” The image will appear in the UserImage display.  
 
The same image display components used for camera images are available for User Images. For 
details on how to adjust images see 4.1.  For details on how to rotate images etc. see 5.3 and 5.4.
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7 Catalogs 
Any time a target is selected a catalog query is performed for the region surrounding the target. 
A variety of online and local catalogs are available which include those listed below.  The GSC, 
SAO and HIP are archived locally.  The GSC2 is the default catalog.  Available catalogs are: 
 

• GSC23 
• Nomad 
• 2Mass 
• USNOB10 
• VGSC2 (default) 
• GSC 
• SAO 
• HIP 

 
The choice of which catalog service to use is selectable from the main menu. Choose Catalogs 
and then the catalog name to use. The current selection is checked. If you have already selected a 
target and want to change the catalog for that target, then change the catalog name and refresh 
the target.   
 
It is possible to specify a radius and range of magnitudes to use for the catalog query. These are 
available on the target panel. If you want to change the search radius and/or the vmag range after 
you have selected the target you should use “Refresh” to update the information. 
 
Searching the catalog produces a table as is shown below. The catalog table has the same sorting, 
column reordering, filtering and highlighting capabilities as the starlist table.  
 
Information on the objects listed in the catalog table can be overlaid onto the DSS. If the catalog 
overlay is visible it is possible to interact between the overlay on the DSS image and the catalog 
table. Clicking on an overlay item in the DSS will highlight that item in the catalog table. 
Likewise clicking on an item in the catalog table will highlight that item on the overlay by 
setting it yellow. 
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Figure 6 Sample catalog Table 

The first entry is always the actual primary target. 
 
Id The catalog name of the star  
RA The Right Ascension of the star in hours 
Dec The Declination of the star in degrees 
Rmag The R Magnitude of the target, if specified 
Vmag The V Magnitude of the target, if specified 
B_R B – R if specified 
B_V B – V if specified 
Dist The distance of the item from the target in degrees 
Galaxy If set the catalog item is no a star 
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8 Starlist and Target Management 
It is possible to map the  starlist which the OA is currently using into the observer UI so that you 
can easily use it to interact with the OA. Once mapped the observer can: 

• Dynamically add items to the starlist 
• Dynamically remove items from the starlist 
• Highlight items from the starlist so that they appear highlighted on the OA UI. (useful for 

indicating the next target to be observed) 
 

 
Figure 7 Sample Starlist table 

Index Numerical index, this is the order the item is first encountered in the starlist. If a 
starlist has duplicate entries the same name will appear but with different indexes. 

Name Target name 
RA/Az If the target is using FK4, FJK5 or APP then this shows the Right Ascension in 

hours. If it is using Mount coordinates then this is the Azimuth in degrees. 
Dec/El If the target is using FK4, FJK5 or APP then this shows the Declination in 

degrees. If it is using Mount coordinates then this is the Elevation in degrees. 
Equinox Equinox of target 
Mag Magnitude of the target, if specified 
PMRA RA proper motion adjustment if specified  
PMDEC Dec  proper motion adjustment if specified 
DRA RA differential tracking adjustment if specified. 
DDEC Dec differential tracking adjustment if specified. 
Rotmode Rotator mode to use 
Rotdest Rotator angle to use 
Starlist The full path to the starlist 
 
All tables in MAGIQ can be sorted, columns can be re-arranged and items can be filtered or 
highlighted. 
 

8.1 Sorting a table 
You can sort based on any of the columns in a table by clicking on the column header. Clicking 
once will sort in ascending order, clicking again will sort in descending order. A small arrow in 
the column header indicates the direction.  
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8.2 Arranging columns (Advanced) 
To re-arrange the columns in a table simply click the column holding down the mouse and drag 
it left or right to the position you want, then release the mouse. Columns can also be made larger 
or smaller by dragging the column with the mouse. 

8.3 Filtering or highlighting items (Advanced) 
To enable filtering in a table, press CTRL-F while the table has focus or use the filter button that 
appears on the panel toolbar. It is the first button.  A small dialog will appear at the bottom of the 
table allowing a filter string to be entered.  

 
The filter or highlight operation is not case sensitive. Press Filter to perform the actual filtering. 
Press Highlight to just highlight using the filter string. For filter all the items are compared 
against the filter string and when applied the starlist contents will adjust to only display the items 
that matched the filtered set. For highlight all the items will continue to be shown but items 
matching the filter string will be shown in a different color.  
 
To remove a filter or highlight; press the Clear button. 
 

8.4 Mapping / Sharing the OA starlist 
The MAGIQ server must be running and the OA must have loaded a starlist before performing 
this operation. 

• Select "File" from top menu  
• Select "Map OA Starlist"   
• Targets will appear in the starlist table 

 
You can confirm that the correct list is loaded by looking under the “StarList” column of the 
table. It is the last column and you may need to scroll to it. 

8.5 Loading a private starlist (Advanced) 
Multiple private starlist can be loaded. These provide all the same features of the main starlist 
but are not shared with the OA. The default directory for the starlist is /kroot/starlists.  The 
starlist file must follow the SKY format (standard Keck format for starlists).  To load one or 
more starlists 

• Select "File" from top menu  
• Select "Load Private Starlist"  
• From Dialog, select starlist of choice  
• Click on “Select a starlist to Open” 

 
The new starlist will appear under a new tab, following the main starlist. 

8.6 Appending to a private starlist (Advanced) 
You can add/append one or more starlists together into a single starlist. This only applies to 
private starlists. To do so 
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• Select "File" from top menu  
• Select "Append To Private Starlist"  
• Choose the starlist to append to from the sub-menu 
• From Dialog, select starlist of choice  
• Click on “Select a starlist to Open” 

 

8.7 Saving a starlist 
It is possible to save a mapped or private starlist back to file by using the “Save Starlist” button 
on the starlist panel toolbar. It is represented by the standard save icon. Once pressed, a dialog 
will open allowing you to enter the directory and filename. Press “Save Starlist” on the dialog to 
complete the operation. 

8.8 Selecting a target from the starlist 
To select a target simply click on object with left mouse button. Once selected a number of 
things happen: 

• Preview panel will update for target 
• DSS image will update for target (if auto retrieval is enabled) 
• Catalog info will update for target (if auto retrieval is enabled) 

 

8.9 Target Refresh 
Refresh applies to whatever target is currently selected in the table. Refresh will: 

• Force a preview update 
• Retrieve DSS image for this target, if not cached 
• Retrieve catalog overlay information for this target, if not cached 

 

8.10  Target Preview 
The preview panel is updated automatically whenever a new target is selected in the starlist (or a 
target is refreshed). It is also automatically updated every 10 seconds, if “Live Preview” is 
enabled. The preview window display information for this target at the present time (time to 
limit, airmass, etc.)  To get preview information for this target at some other time (i.e. what is the 
airmass one hour from now ?) you can uncheck “Live Preview” at the lower right of the preview 
window, then type in a new LST.  The preview values will then be computed for the new LST. 
 

 
Figure 8 Preview Panel 
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The fields are as follows and are applicable to the current selection: 
Tel Time to Limit Time until telescope reaches limit in hours:minutes 
Above Limit Time the target becomes visible (Blue is past, Red is future) 
Below Limit Time the target goes below limit 
Est Slew Time: Estimated time to slew to selected target from current position 
  
Parallactic The parallactic angle at limit 
Airmass The airmass at limit 
Az The current azimuth value for this target 
El The current elevation value for this taregt 
  
Rot Time to Limit Time until rotator reaches limit in hours:minutes 
Rotpdest Physical rotator angle at limit 
Direction The direction the limit will occur in. 
Rotdest Rotator user angle at limit 
  
CW Lim Value used for Clockwise rotator limit 
CCW Lim Value used for Counter Clockwise rotator limit 
Live preview If selected the current LST is used 
LST If “Live Preview” is selected this constantly updates with the current lst. If 

not selected then any LST can be entered here to preview for a given time. 
Format is hh:mm:ss 

 

8.11  Highlight a target from starlist on the OAs screen 
This feature is useful when you want to let the OA know what the next target should be or to 
discuss the possibility of observing a particular target in planning subsequent observations.   
Only one target at a time can be highlighted on the OA screen. The currently selected item will 
be highlighted in yellow.  To do this: 

• Select the object from starlist 
• Press right mouse within starlist window 
• Select "Highlight as next target " from popup menu 

8.12  Adding a new target 
Select the target tab to get a target panel which will allow you to manually enter a new target. 
This target can then be added to the main starlist. 
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Figure 9 Target panel 

Once the information has been entered, press “Add” to add the item to the main starlist. 
 
Note: this panel does double duty. It is also used to change the search radius and magnitude 
ranges for catalog retrieval. In addition the rotator angle and mode can be changed so that these 
are factored into preview calculations. 

8.13  Removing a target 
To remove a target from a starlist do the following: 

• Select object from starlist 
• Press right mouse within starlist window 
• Select "Remove target from list" from popup menu 

8.14  Resolving a target by name 
To resolve an item by name using the same service; enter the target name into the target panel 
and press “Resolve”. The RA, Dec and Equinox fields will update. 

8.15  Using the current target 
To get the DSS and catalog information on where the telescope is currently pointing, press “Get 
Current” to retrieve the current target information and then press “add” to add it to the starlist or 
“List” to just retrieve the DSS and catalog information. 
 

8.16 Fetch DSS and catalogs for starlist 
This task will retrieve and cache the DSS and catalog overlay information for each item in the 
starlist. To fetch and cache DSS and catalog information for the starlist, right click within the 
starlist table and chose “Fetch DSS and catalogs for starlist” 
 
Choosing this menu item will launch the MagiqCacheGeneraor task in the background. There is 
no visible cue that the retrieval is happening, though a log file called, MagiqCachegeneraor.log 
does get created. 

8.17 Extended Previews 
An extended preview can be generated for any starlist or subset of a starlist. The extended 
preview can be launched from the observer or OA UI or can be run as a standalone program. The 
user can load a starlist through the File menu. The starlist is loaded automatically when this UI is 
launched via a right mouse click from the main UI. 
 
The extended preview view contains three tabs, which consist of an elevation, observation chart 
and tabular information. All times along the x axis can be displayed in UT, LST or HST. In the 
elevation plot, elevation and airmass and optionally parallactic angle are plotted over time. The 
user can select whether to plot elevation, angle or both together for the selected targets. Plotting 
elevation and parallactic angle together becomes messy very quickly if there are a large number 
of targets. 
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The observation chart shows twilight and dark time for the night and shows the timeline over 
which each object overlaps. For each target the maximum elevation during the night is shown 
and if a target’s elevation comes within a certain delta of zenith it is changed to red on the chart. 
(Since Keck is an alt-az telescope, a small region around the zenith is not accessible.) It is 
possible to create multiple observation charts based on certain criteria such as elevation, amount 
of observable time.  One can also restrict the number of items per graph. For a large starlist the 
observation chart will automatically create multiple plots each containing a number of objects 
small enough to keep the display usable. The charts can be saved as JPEG files in the nightly 
directory, for later use or for printing. 
 

8.18 Immediate starlist plot 
Choosing this menu item will launch the MAGIQ extended preview window. This is a separate 
UI that once launched can be operated independently from the main UI.   Its functionality is 
described above. 
 
With this option all targets in the starlist are plotted.  This can produce a messy plot difficult to 
interpret if there are a large number of targets in the current starlist.. Once the extended preview 
dialog is up it is possible to manage which targets are plotted using the View->Targets menu. If 
you only want to plot a subset then the “Deferred starlist plot” might be the best choice. 

 
Figure 10 Extended Preview Window 

 

8.19 Deferred starlist plot 
Choosing this menu item will launch the MAGIQ extended preview window whose functionality 
is described above.. This is a separate UI that once launched can be operated independently from 
the main UI.   
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With this option no targets are initially plotted. Using the View->Targets menu you can select 
which items to plot. Options include plot all, plot none or plot selected targets from the starlist. 

8.20 Plot selected target 
This brings up the same UI and graph as above but only plots the selected target. 
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9 Information Panels 
There are a number of UI panels that display telescope, guider and camera telemetry information 
in both a textual and graphical format. 

9.1 Telemetry  
This panel is like a mini facsum and displays information about the current target and telescope 
state. 
 

 
Figure 11 Telemetry Information Panel 

 
Telescope Telescope state 
Instrument Current instrument 
Target Current target 
Pointing 
Origin 

Current PO 

Diff Track Shows if Differential Tracking is enabled or not 
Az Current Az 
El Current El 
RA Current RA in hours 
Dec Current Dec in degrees 
Diff Guide Shows if Differential Guiding is enabled or not (DOFFGE) 
Rotator Rotator state 
Sky PA Current Sky PA 
Drive Rotator drive position 
LST Current LST 
DRA RA differential tracking rate for current target 
TTL Telescope time to limit for current target 
RTTL Rotator time to limit for current target 
PMRA RA proper motion for current target 
PMDE DEC proper motion for current target 
DDEC DEC differential tracking rate for current target 
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9.2 Guider Info (Advanced) 

 
Figure 12 Sample GuiderInfo panel 

This panel provides telemetry information on the camera and guider. 
• The panel provides information about the camera image and current guider state.  
• Camera related information is on the top and guider information on the bottom. 

 
 
 

9.3 Graphs 
There are a number of real time graphs that display FWHM, sky and star counts, SNR and 
centroid X,Y information for the last ten minutes. All graphs auto scale. 
 
To change the properties of a graph, right click on the graph.  This will bring up a pop-up menu 
that allows you to change the X and Y axis labels, ranges, etc.  (General hint: if you want to 
change the properties of a display window, try right-clicking on it.) 

 
Figure 13 Sample graphs 

9.3.1 Zooming a Graph 
The following works when the cursor is positioned on the graph. 
Zoom in by holding down the left mouse button on the area of interest and moving to the right. 
Zoom out by holding down the left mouse button and dragging it to the left. 



MAGIQ Software Team     Page 28 of 38 
Observers User Interface Guide for MAGIQ     Revision: 0.03 10/6/2008 
 

9.3.2 Changing scale 
All graphs auto scale based on the range of the dataset. It is possible to manually change the 
range by right clicking and using the graph properties. To manually set a range 

• Select the Plot tab 
• Select the Range Axis 
• Under Other, select Range 
• Unselect “Auto adjust range” and manually enter the upper and lower range. 

 

9.4 Preferences 

 

9.4.1 Modify Defaults 
Displays a dialog box allowing various defaults to be changed. Press Save on the dialog to allow 
the changes, Cancel to ignore any changes. 

 
 
 Default items that can be changed include: 

• The maximum number of catalog items to list after a query 
• The maximum number of pointing stars to list after a query 
• The LTCS FOV to use in the LTCS Queries 
• The logging level to use in MAGIQ, the default is WARN 
• If Automatically Request Overlays is selected, which is the default, each time a new 

target is selected the DSS and catalog for that target will be selected. Items are 
automatically cached after the first query.  
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9.4.2 Scale Interpolation 
Determines the scale interpolation to use when scaling a camera or DSS image. NEAREST is the 
default and fasted. Other options typically gives smoother results though that may not necessarily 
be the best for guider images. 

9.4.3 Smooth Scrolling 
When enabled the main image window continuously updates, scrolls, when the image is being 
panned. Enabled is the default. If the option is not set the image only updates after a pan is 
finished. 

9.4.4 Show GSC Names 
If enabled the catalog item names are displayed as part of the catalog overlay, otherwise only the 
catalog item markers are display. 

9.4.5 Show GSC Grid 
If enabled a grid is displayed over the DSS image showing the RA,Dec at each grid point. 

9.4.6 FOV Color 
Sets the color to use for the FOV layer. 

9.4.7 GSC Color 
Sets the color to use for the catalog overlay layer. 

9.4.8 Compass Rose Color 
Sets the color to use for the compass roses. 

9.4.9 Fiducial Mark Color 
Sets the color to use for fiducial point markers on the camera images. 
 

9.5 Themes (Advanced) 

 
This menu allows the UI to be assigned a different look and feel. Changes are minor and include 
background colors, tabs sizes etc. 
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9.6 Layout Manager (Advanced) 

 

9.6.1 Freeze Layout 
This is set by default. When set, the overall window can be moved and sized but individual 
panels are locked in place. When unselected, each of the panels can be moved around, 
minimized, maximized or floated. 

9.6.2 Default Layout 
This restores any layout to the default. This option can always be used to recover from a corrupt 
layout file or mistake in arranging a layout. 

9.6.3 Save Layout 
This saves the current layout to a file which can be reloaded later. 

9.6.4 Load Layout 
This loads a previously saved layout and re-arranges the UI based on the contents. 
 

9.7 Show View 

 
This menu gets dynamically updated. It will also show the regular panels and depending on what 
other panels are loaded, such as private starlist, it may also include additional views.  Selecting 
any item in the menu causes the panel to be made visible, and brought forward into UI focus. 
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10 Appendix A – Brief Summary of MAGIQ 
Features 

10.1  Starlists 
Loading 

Share the OA starlist •  Select "File" from top menu  
•  Select "Map OA Starlist"   

Load one or more private starlist(s) 

•  Select "File" from top menu  
•  Select "Load Private Starlist"  
•  From Dialog, select starlist of choice  
•  Click on “Select a starlist to Open” 

Append to an already open starlist 

•  Select "File" from top menu  
•  Select "Append To Private Starlist"  
•  Choose the starlist to append to from the sub-menu 
•  From Dialog, select starlist of choice  
•  Click on “Select a starlist to Open” 

StarList operations 

Select an item from a starlist 

• Click on object with left mouse button 
• Preview panel will update for target 
• DSS image will update for target (if auto retrieval 
is enabled) 
• Catalog info will update for target (if auto 
retrieval is enabled) 

Highlight a target from starlist on 
OAs screen 

• Select object from starlist 
• Press right mouse within starlist window 
• Select "Highlight as next target " from popup menu 

Add an item to a starlist 

•  Fill in information on Target Panel 
•  Press the “Add” button 
 
For known objects “Resolve” can be used to retrieve the 
object information via Sesame 
To use the current telescope target press “Get Current” 

Remove an item from a starlist 
• Select object from starlist 
• Press right mouse within starlist window 
• Select "Remove target from list" from popup menu 
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Cache DSS and Catalog 
information for a starlist 

• Press right mouse within starlist window 
• Select "Fetch DSS and catalogs for starlist " from popup 
menu 

Plot rise times for selected object 

• Select object from starlist 
• Press right mouse within starlist window 
• Select "Plot selected target" from popup menu 
 
Graph will appear showing Airmass, elevation, parallactic 
angle and observable times for object 

Plot rise times for all objects in the 
starlist (deferred) 

• Press right mouse within starlist window 
• Select "Deferred  starlist plot" from popup menu 
 
Graph will appear. No objects are visible in graph. Use 
View->Tragets->Add from Extended Preview UI to graph 
objects 

Plot rise times for all objects in the 
starlist (immediate) 

• Press right mouse within starlist window 
• Select "Immediate starlist plot" from popup menu 
 
Graph will appear showing Airmass, elevation, parallactic 
angle and observable times for all objects 

Filtering/HighLighting 

Show / Hide the Filter bar • Toggle “Toggle List Filtering” on starlist toolbar 

Filter (Display) only specific items • Enter string into Filter: field on Filter Bar 
• Press the Filter button 

Hightlight specific items • Enter string into Filter: field on Filter Bar 
• Press the Highlight button 

Show all items • Press  the “Clear” on the Filter bar 

DSS and Catalog  Auto Retrieval 

Enable / Disable DSS Automatic 
retrieval for targets • Toggle “Auto retrieval” on starlist toolbar 

 

10.2  All Images 
Zooming/Panning 

Zoom in (absolute) •  Use image toolbar 
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•  Press “Zoom In” button 

Zoom out (absolute) •  Use image toolbar 
•  Press “Zoom Out” button 

Zoom to Fit (absolute) •  Use image toolbar 
•  Press “Zoom to Fir” button 

Zoom normal (absolute) •  Use image toolbar 
•  Press “Zoom Normal” button (i.e. no Zoom) 

Set zoom factor (relative) 

•  Click on image  
•  If mouse wheel available – use wheel to change zoom 
•  If no mouse wheel available – hold and drag middle button to 
change zoom 

See Current Zoom and 
Binning 

•  Use image toolbar 
•  Zoom and Binning appears as n x mb 

Overlay Guider FOV •  Use image toolbar 
•  Press “FOV” button  

Adjusting Image Scaling/Colormap 

Adjust contrast/bias (DS9 
style) 

•  Hold down shift button 
•  Place cursor on image  
•  Click and drag with RIGHT mouse  
•  Contrast is vertical, Bias is Horizontal direction 

Adjust contrast/bias •  Use contrast and bias slider bars  

Change color 

•  Use image toolbar 
•  Select color from “Color” dropdown 
 
Grey is default 

Change scaling 

•  Use image toolbar 
•  Select scale algorithm from “Scale” dropdown 
 
Linear is default 

Change cut levels 

•  Use image toolbar 
•  Select cut level algorithm from “Cut” dropdown 
 
ZScale is default 

Change intensity •  Use image toolbar 
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•  Select intensity algorithm from “Intensity” dropdown 
 
Ramp is default 

Restore defaults •  Use image toolbar 
•  Press the “Defaults” button 

Pan/Magnify 

Pan 
• Ensure Pan/Magnify window is visible 
• In Pan window click on image and drag to new location 
• Release mouse 

Magnify • Ensure Pan/Magnify window is visible 
• Move around main image, magnified image appears in box 

Image Information 

Cursor X,Y Position •  Place cursor on image  
•  1st column in status bar shows current X,Y position 

Pixel Value at X,Y 
•  Place cursor on image  
•  2nd column in status bar shows pixel value for the current 
cursor position 

WCS Ra, Dec 
•  Place cursor on image  
•  3rd column in status bar shows current Ra, Dec information for 
Camera Image and WCS info from DSS if available 

WCS Az, El 
•  Place cursor on image  
•  4th column in status bar shows current Az, El information for 
Camera Image and WCS info from DSS if available 

 

10.3 Camera Images 
Image Operations 

Print Current Image •  Use image toolbar 
•  Press “Print” button 

Save Current Image •  Right click on image 
•  Choose “Save Image as …” from popup menu 

Mark Fiducials 
•  Right click on image, at point of interest 
•  Select "Mark Fiducial"  
•  Repeat as needed 
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Clear Fiducials •  Right click on image  
•  Select “Clear Fiducial” 

Create a marker on the OA  
display 

•  Right click on image, at point of interest 
•  Select "Set Marker"  

Clear Marker •  Right click on image, at point of interest 
•  Select "Clear Marker"  

Image Statistics 

Measure centroid/size 

•  Select "Camera" from top menu  
•  Select "Examine Objects" to get "examine objects" popup  
•  Click on area of interest 
•  FWHM and other information will appear in popup 

Image Information 

Ra, Dec from PO 
•  Place cursor on image  
•  5th column in status bar shows current Ra, Dec offset from the 
current PO 

XIM, YIM at Cursor 
position 

•  Place cursor on image  
•  5th column in status bar shows current Guider XIM, YIM at 
current cursor position 

 

10.4  DSS Images 

Manually Rotate Image 
•  Use image toolbar 
•  Enter the angle in degrees to rotate 
•  Press the “Rotate” button 

Automatically Rotate 
Image (Track Guider) 

•  Use image toolbar 
•  Toggle the “Track” button 

Catalog overlay •  Use image toolbar 
•  Toggle the “Catalog overlay” button 

Show Grid with Catalog 
Overlay 

•  Select "Perferences" from top menu 
•  Toggle "Show GSC Grid"  

Show item names for 
Catalog Overlay 

•  Select "Perferences" from top menu 
•  Toggle "Show GSC Names" 

Show FITS keywords •  Select "DSS" from top menu 
•  Select "Show DSS FITS Keywords" 
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10.5  User Images 

Load User Image 

•  Select "File" from top menu  
•  Select "Load Image"  
•  Select image of choice from dialog 
•  Click on “Select an image to load” 

Manually Rotate Image 
•  Use image toolbar 
•  Enter the angle in degrees to rotate 
•  Press the “Rotate” button 

Automatically Rotate 
Image (Track Guider) 

•  Use image toolbar 
•  Toggle the “Track” button 

Catalog overlay •  Use image toolbar 
•  Toggle the “Catalog overlay” button 

Show FITS keywords •  Select "UserImage" from top menu 
•  Select "Show UserImage FITS Keywords" 

 

10.6  Telemetry 

Telescope Telemetry 
•  Use Telemetry Tab 
 
Displays information on current target, current position, limits etc. 

Guider Textual 
Presentation 

•  Use Guider Tab 
 
Displays Guider and Camera information 

Guider Graphical 
Presentation 

•  Use FWHM, Counts (Sky and Background), Centroid and SNR 
graphs 

 

10.7  Layout 

Enable Docking •  Select "Layout Manager" from top menu  
•  Toggle "Freeze Layout” so that option is not selected  

Disable Docking •  Select "Layout Manager" from top menu  
•  Toggle "Freeze Layout” so that option is selected  

Restore Default Layout •  Select "Layout Manager" from top menu  
•  Select "Default Layout” 
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Load workspace 

•  Select "Layout Manager" from top menu  
•  Select "Load Layout” 
•  Select Layout file from dialog 
•  Press Open 

Save workspace 

•  Arrange Layout 
•  Select "Layout Manager" from top menu  
•  Select "Save Layout” 
•  Specify filename and directory in dialog 
•  Press Save 

 
 

10.8  MAGIQ Log Files 
MAGIQ log files are intended for both debugging purposes (tracing the cause of errors and 
problems) and for archiving of sky and guider conditions.  They go into the nightly directory. All 
log entries are time stamped in HST.  

• MagiqServer.log 
o Primary log file, includes all low level actions, including DCS and guider 

interactions 
• MAGIQ_OA_UI.log 

o Logs any errors with the U and all OA actions 
• MAGIQ_Observer_UI.log 

o Logs any errors with the observer UI. 
 

10.9  How to communicate with the OA UI 

10.9.1 Use Starlist 
Assumes Map OA Starlist has been performed. 
To highlight a target as the next target: 

• Select the target in the starlist 
• Right click 
• Choose “Highlight as next target” from the popup menu 

10.9.2 Use Camera Image 
Assumes camera images are being updated. 
To highlight an area of interest on the OA UI: 

• Right click on the camera image at the x,y position/on the object you want to highlight 
• Choose Set Marker from the popup window 
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11  Appendix B – Zero Points for NIRSPEC MAGIQ 
Camera 

 
Tests during the March 2008 engineering run suggest the following for the performance of the 
MAGIQ camera on NIRSPEC: for a star of mag 18.0 in each of V, R and I, the net DN per sec is 
9,800 for the V filter, 11,800 for the R filter, and 4,500 for the I filter. 
 
The scale of the MAGIQ guider camera on NIRSPEC is 0.20 arcsec/pixel. 
 
 


